Oracle
Primavera Unifier
Bluebeam User Guide

Version 25
April 2025



Oracle Primavera Unifier Bluebeam User Guide
Copyright © 1998, 2025, Oracle and/or its affiliates.

Primary Author: Oracle Corporation



Contents

L0 Y= 1 SO 5
ST T T =R 0o T = 01T o= = o 7
Setting Up Markups and Comments in BlUEDEAM ......ccccceriiicciimmrrrnrnnissssssssersesesssssssssssssssesssssssssnnes 9
Setting Up Permissions for End Users to Access Bluebeam Studio Sessions........cccceerrrrrrinscssnnees 11
Bluebeam Studio Sessions in Document Manager and Business Processes Records..........cccuee.. 13
Creating and Viewing Bluebeam Studio Session in Document Manager ......cccccveeeeeeveeeecccneeeeecee 13

SEIECT FIlES WINUOW .eieieicetiee et s ettt s s e st e e s s e e e s se e e s s eann e e s s esseeeesnnnnennan 14
Bluebeam Log Tab in the DOCUMENT MANAGET ......cocieiiieereeeeereeerreeesee e e s e e e sne e s e s e e s e e e sneeeane 15
Creating and Viewing a Bluebeam Studio Session in a Business Process Record........cccccceeeenneee. 16

o Lo I 11 =TS0 T o [ 1 R 17
Bluebeam Log Tab in @ BuSiNess ProCess RECOIT .......cocerreierriereiee e e 18
Bluebeam Studio SESSIONS LOG .....cieceomiriieeierieeecer e e e e e e e s esssse e e e s s s sme e s esme e s me e e s e e e enn 21
Creating a Bluebeam Studio Session in Bluebeam Studio SeSSIoNS.......cccccceerievceeeecccieesccceee e 23

Create Bluebeam Studio SESSION WINUOW ...ccoccueiiiiiiieieeisieeee s scete e s sseee e seeee e s sese e e s ssssee e s ssseeessnanee 23
Opening a Bluebeam Studio Session in Bluebeam REeVU ........coccrieeirie i 24
Editing a Bluebeam StUAIO SESSION ......uiiiiciiirccciee et s et e e e e s e e e e e ne e e e e ane e e e e aneeas 25
Finalizing a Bluebeam STUdIO SESSION ....cccuuiiiiicierccceeee et e e s e e e sne e e e ne s 26

Replacing the Original File with @ ReVISEd File........oi i 27
Deleting a Bluebeam StUdio SESSION.....cii e et r e e e e e e e s e s e e ae e s e ane e e s e anees 28
WOTKING WIth LOE VIEWS......eeiiiiiiiies ettt s et s st e e s st e s e s e e e e e sa e e s e ana e e s e e ans e e s s nnneeesennnneesannnneenan 28
FINAING ON PAEE ... et e e e e e s s e e e e s e e s ne e s e e e e ne e e ene e e e neesaneesenneesnnesanneesnnnesans 29
L0 T = 7o V0 Y o PR 29
Bluebeam Studio Sessions LOZ Propertie€s TabS.....uccciiricieiereeieiee s eeeesecee e s e see e s e e s e sne e s e ne s 30

Viewing Markups and COMMENTS .....couioiiiieeeeceeeeeee e ree e see e s e e s se e sese e s s sne e s e e e eneeseme e s sneesenneesn 34






Overview

Note: The information provided in this document is subject to change.

Bluebeam is a markup and collaboration tool that is widely used by customers throughout the
world. Its main products are Revu and Studio Prime. While Revu allows customers to create
collaborative sessions in which users can bring in multiple documents and review them together,
Studio Prime has more advanced features like the ability to create/manage documents within
folders, create projects and add collaborative document review sessions within them. Within
Unifier, users can send their documents and files to Bluebeam for review sessions. Users can
bring the reviewed files and markup comments back into the application to take the next
appropriate actions.

Unifier integrates with Bluebeam Studio Prime where all the sessions and files are held. Revu

then connects to Studio to access the sessions. To use Revu, you must have an account in
Studio Prime as well.

The Bluebeam admin must complete steps to assist in the initial setup and configuration of
Bluebeam as an integrated collaborative third-party program within the Unifier environment.
These steps include the Bluebeam admin taking the following actions:

» Downloading Primavera Unifier Wallet (a zip file) from My Oracle Support for Bluebeam.
For more information, see the Primavera Unifier Installation Guide for On-Premises.
Enabling Bluebeam integration
Filing a service request with Oracle Support for OAuth authentication
Add Unifier Application into Bluebeam account

Note: Bluebeam documentation is the most accurate reflection of the
Bluebeam software. The Bluebeam searchable knowledge base is
available by way of the following link: https://support.bluebeam.com/.






Setting Up Bluebeam

Make sure that the Bluebeam administrator has completed the preliminary steps described in the
Overview.

To set up Bluebeam in Unifier:

1) Sign into Unifier.

2) Go to the Company Workspace tab and switch to Admin mode.

3) Inthe left Navigator, select Integrations, and then select Bluebeam.
4) Inthe General tab, under Enable Integration?, select Yes.

When the integration is enabled, a Client ID is displayed. This ID is used when configuring
the integration within Bluebeam.

As part of the authentication, you need to capture the URLSs that will be used for Bluebeam
integration by filing a service request with Oracle Support that includes the URLs of all the
environments that will have the integration enabled.

5) Click Save.

Note: The Unifier user must have an active Bluebeam Studio Prime
subscription.






Setting Up Markups and Comments in Bluebeam

To set up Markups and Comments in Bluebeam:

1) Sign into Unifier.

2) Go to the Company Workspace tab and switch to Admin mode.

3) In the left Navigator, select Integrations, and then select Bluebeam.

4) Inthe Comments tab, select the Enable creation of Line Items from Comments of the
Review Session check box.

When this option is selected, line items will be created in the business process records that
have the fields to capture Bluebeam Review comments. Line ltems can only be created after
the Bluebeam Attributes are mapped to Unifier Data Elements. After selecting this option, the
Attribute Mapping block and the Bluebeam Attribute setup blocks appear.

5) To map attributes:

a. Click + Add.

b. Inthe Bluebeam Attribute column, enter the name of the Bluebeam attribute from
Bluebeam Revu.

c. Inthe Bluebeam Attribute Sub-Type column, select the subtype from the menu.
d. Inthe Unifier Data Element column, select the data element from the menu.
6) To add a condition:
a. Type an attribute into the Bluebeam Attribute field.
b. From the menu in the middle column, select equals or does not equal.
c. Enter a comment in the Value field.
7) Click Save.

Tip:
Line items can only be populated with attributes that are present in the Bluebeam markup list. To
determine the attribute name, you can try a few sample runs in staging.

» Create a Bluebeam session in Unifier with a PDF.

» Review using Bluebeam Revu with all possible markups.

» After the session owner finalizes the session, the markup files are available in the Received
Files tab. You can download the file by selecting the gear menu ( {3 ) and choosing the
Download JSON File option.

The attributes in JISON are as obtained from Bluebeam and can be used a reference for the
Bluebeam attributes in the Comments tab.

View and Configure Permissions

Users with Configure permissions can:

» Edit the Comments tab.
» Edit the Unifier Data Element column.
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» Add new rows in the grid.
» Delete newly added rows.

Users with View permission can view the page but cannot make any changes.

To edit Configure and View permissions:

1) Gotothe Company Workspace tab and switch to Admin mode.
2) In the left Navigator, select User Administration, and then select Access Control.

3) Expand the Administration Mode Access node, expand Integrations, and select
Bluebeam.

The Module Permission Settings dialog box appears.
4) To add user permissions:

a.

©ooo

f.

Click Add.

In the Permissions/Access Control dialog box, click Add Users/Groups.

In the User/Group Picker dialog box, select users or groups and click Add.

Click OK.

In the Permissions/Access Control dialog box, select the Configure or View options.

= Users with Configure permissions can edit the Comments tab, edit the Unifier
Data Element column, add new rows in the grid, and delete newly added rows.

= Users with View permission can view the page but cannot make any changes.
Click OK.

5) To modify user permissions:

a.
b.
c.

Check the box next to the user you want to modify, and click Modify.
In the Permissions/Access Control dialog box, select the Configure or View options.
Click OK.

6) To remove user permissions:
a. Check the box next to the user you want to modify, and click Remove.

b.

10
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Setting Up Permissions for End Users to Access
Bluebeam Studio Sessions

Bluebeam Studio Sessions node will allow users to create new Bluebeam Studio sessions and
see a log of all ongoing Bluebeam Studio sessions existing for the files in the Document
Manager and for business process record attachments.

To set permissions for Bluebeam Users:

1) Goto the Company Workspace tab and switch to Admin mode.
2) Inthe left Navigator, select User Administration, and then select Access Control.

3) Expand the User Mode Access node, and then expand either Company Workspace or
Projects/Shells.

4) Expand Document Manager and click Bluebeam Studio Sessions.

Note: The location of the Bluebeam Studio Sessions is dependent on
the setup of the User Mode Navigator.

You can assign the following permissions:

Permission Expected Behavior When Checked

Create A user with the "Create" permission will

have the ability to:

» Create a Bluebeam studio session.

» View and edit the Bluebeam Studio
Sessions log and its details.

» Perform actions such as Finalize, Get
Review Status, Assign Full Control
permission to a reviewer, and so on.

View A user with the "View" permission will have
the ability to view the Bluebeam Studio
Sessions log and its details.

11






Bluebeam Studio Sessions in Document
Manager and Business Processes Records

You can create Bluebeam studio sessions only if your company has decided to enable
integration with Bluebeam in the Company Workspace, which accessed by select the Integration
node and then selecting the Bluebeam sub-node.

Note: Only PDF files may be selected and sent for a Bluebeam Review
Session.

In This Section

Creating and Viewing Bluebeam Studio Session in Document Manager.................. 13
Bluebeam Log Tab in the Document Manager............cceevieeeiiieeiiiiiiiiee e 15
Creating and Viewing a Bluebeam Studio Session in a Business Process Record ..16
Bluebeam Log Tab in a Business Process ReCOrd ............oooovevviiiiiiiiiiiieeeiiieeeeeen, 18

Creating and Viewing Bluebeam Studio Session in Document Manager

You can initiate a Bluebeam studio session for files that are stored in Unifier's Document
Manager. The steps to create the review session will be the same for both Company
Documents and project Documents.

Notes:

= When a Bluebeam session with files is created in Unifier, these files
can also be viewed in Bluebeam Revu as they are associated with a
Bluebeam Project. Ensure that you do not delete the project in
Bluebeam Revu or Bluebeam portal as this will cause the session to
fail in Unifier. Unifier will not be able to return the markup documents
if the project is deleted.

= Bluebeam sessions created in Unifier should be finalized only in
Unifier and not in Bluebeam Revu. The "Received" files, that is, the
markup documents, will be available only if the corresponding
session is finalized from Unifier.

To create a Bluebeam studio session in the Company Documents or Documents sub-node:

1) Go to the Company Workspace or project/shell tab and switch to User mode.

2) Inthe left Navigator, select Document Manager, and then select Company Documents or
Documents.
There are two methods to initiate a Bluebeam studio session in Company Documents or
Documents:

13
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» To initiate a review session for a single file, click the gear menu ( & ) or right-click a
document to send for review and select Initiate Bluebeam Studio Session.
» To initiate a review session for multiple files, click the 2 .
3) Upon creation, log in to your Bluebeam account.

Note: You must use the same Bluebeam account going forward.

4) If this is the first time that you are logging on, click Allow when you are prompted to grant
access to your Studio data.

Create Bluebeam Studio Session will open.

Additional files may be added by clicking Add Files. If virus scan is enabled in your
environment, the files are checked and an appropriate alert message displays. Infected files
and files with pending scans cannot be downloaded in Bluebeam.

Select Files Window

After clicking Add Files in the Create Bluebeam Studio Session window from the Document
Manager, the Select Files window will open. Select the files you want to add to the Bluebeam
studio session, and then click Select.

The Select Files window toolbar options:

Option Description

Search Enables you search for a file.

Find on Page Enables you to activate the find cells for
each column to find a particular item.

The Select Files window contains the following columns:

Column Description

Name The name of the file.

Comments The associated comments of the file.

Bluebeam Session Status The Bluebeam session status of the file.

Location The location of the file.

Owner The name of the user that owns the file.

Title The title of the file.

Revision No. The revision number of the file.

Issue Date The date the file was issued.

14
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Column Description
Size The size of the file.

After inputting the required Session Name and the associated user or users in To, click Create
Session.

Notes:
= At any given point in time, a document may only be included in one
active Bluebeam studio session.

= Any user who can view the document can initiate a Bluebeam Studio
session.

After you create a Bluebeam studio session, the status of the document that has been added to
the Bluebeam studio session will show Active (under the Bluebeam Session Status column), in
the Company Documents or Documents sub-nodes of the Document Manager. The created
session will be displayed in the Bluebeam Studio Sessions node (log) where you can use the

gear menu ( & ) or right-click to:

» Open in Bluebeam Revu, or
» Finalize the session.

Bluebeam Log Tab in the Document Manager

The Bluebeam Log tab shown in the right pane of the Document Manager lets you view details
of the Bluebeam studio session associated with the selected document.

Only users who have access to the selected document can view and download the files returned
from Bluebeam. These files include the Markup and JSON files.

If a Bluebeam session is Active and you have the applicable permissions, you can open the
session in Bluebeam Revu by clicking the hyperlink associated with the Session ID.

To access the Bluebeam Log tab:

1) Go to the Company Workspace or project/shell tab and switch to User mode.

2) In the left Navigator, expand the Document Manager node, and then click Company
Documents or Documents, depending on which tab you accessed.

3) Inthe Documents log, select the applicable file and click Expand L3 inthe right pane.

The file that you should select is the one that participated in the Bluebeam session for which
the Bluebeam Log appears in the right pane.

The Bluebeam Log tab toolbar options:

» Find on Page
» Refresh

The Bluebeam Log tab contains the following columns:

15
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Column Name Description

Status The review status of the Bluebeam studio
session of the sent file.

Sent File Name The name of the sent file.

Rev. No The revision number of the sent file.

Pub. No The publishing number of the sent file.

Received File Name The name of the received file. Field will

have a value only when the Bluebeam
Studio session is finalized.

Session ID The ID of the Bluebeam studio session.

Session Name The name of the Bluebeam studio session.

Last Updated By The name of the user that performed the
last action for the Bluebeam studio
session.

Last Updated The date and time of when the last action
was performed for the Bluebeam studio
session.

The gear menu ( i ) for each file contains the following options:

» When the session is still active:
» Finalize
» Get Session Status

» When the session is finalized:
» Download Markup File
» Download JSON File

Notes:

= Any user who has access to the selected document can see the files
returned from Bluebeam. These include the Markup and JSON files.

= |f the Bluebeam session is Active, you can get the session details by
clicking the hyperlink associated with the Session ID.

Creating and Viewing a Bluebeam Studio Session in a Business Process Record

You can review all the attachments in a business process record using Bluebeam Studio
Session.

16
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Notes:

= When a Bluebeam session with files is created in Unifier, these files
can also be viewed in Bluebeam Revu as they are associated with a
Bluebeam Project. Ensure that you do not delete the project in
Bluebeam Revu or Bluebeam portal as this will cause the session to
fail in Unifier. Unifier will not be able to return the markup documents
if the project is deleted.

= Bluebeam sessions created in Unifier should be finalized only in
Unifier and not in Bluebeam Revu. The "Received" files, that is, the
markup documents, will be available only if the corresponding
session is finalized from Unifier.

To create a Bluebeam studio session in a business process of workflow and non-workflow type:

1) Open the BP record containing the attachments that need to be reviewed.

2) Inthe upper-right corner of the screen, click the Menu drop-down (three horizontal lines
icon), navigate to Review, and click Bluebeam Studio Session Review.

Note: A Bluebeam studio session can be created only when the record
is in Edit mode. The option to create a session will not be available in the
Creation step. You can initiate a review session for Terminal records
with an Action form in the End step.

3) Upon creation, log on to your Bluebeam account.

Note: You must use the same Bluebeam account going forward.

4) If it is the first time, you will be prompted to grant access to your Studio data by clicking

Allow.

Create Bluebeam Studio Session will open.
5) To add additional files, click Add Files.

Add Files Window

After clicking Add Files in the Create Bluebeam Studio Session window from a business process
record, the Add Files window opens. The list of files seen here are either from the upper form or
from the line items. Files from a hidden tab will not be seen. Select the files you want to add to
the Bluebeam studio session, and then click Add.

The Add Files window contains the following columns:

Column Description
File Name The name of the file.
Title The title, if any, associated with the file.

17



Bluebeam User Guide

Column Description

Pub. No. The publishing number, if applicable,
associated with the file.

Tab Name The name of the tab if the file is present in
a line item attachment.

Size The size of the file.

After inputting the required Session Name and the associated user or users in To, click Create
Session.

Note: At any given point in time, a business process record can have
only one active Bluebeam studio session.

For a workflow business process record, if you accept the task, initiate a Bluebeam studio
session, and then later do an 'Undo Accept Task' action, the session will still remain.

After you create a Bluebeam studio session, the status of the attachment that has been added to
the Bluebeam studio session will show Active (under the Bluebeam Session Status column), in
the Attachments grid. Additionally, the created session will be displayed in the Bluebeam

Studio Sessions log where you can use the gear menu ( {3 ) or right-click to:

» Open in Bluebeam Revu, or
» Finalize the session

Bluebeam Log Tab in a Business Process Record

When the right pane is expanded for a business process (BP) record and the record has a
Bluebeam Studio session, a Bluebeam Log tab is also displayed in the right pane. The
Bluebeam Log tab lets you view details of the Bluebeam studio session associated with the
selected record. You can also view the sessions for any associated line items.

Only users who have access to the selected document can view and download the files returned
from Bluebeam. These files include the Markup and JSON files.

If a Bluebeam session is Active and you have the applicable permissions, you can get the
session details by clicking the hyperlink associated with the Session ID.

To access the Bluebeam Log tab for a BP record:

1) Open the applicable BP record.

2) Maximize the window to ensure that you can see the right pane.

3) In the right pane, select the Attachments tab and then click Expand Ca.

4) On the Attachments tab, select the file that participated in the Bluebeam session.

5) To view the session details associated with the attachment, select the Bluebeam Log tab.

18
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To access the Bluebeam Log tab for the Line Items tab of a BP record:

1)
2)
3)
4)
5)
6)

Open the applicable BP record.

Maximize the window to ensure that you can see the right pane.

Select the Line Items tab.

In the right pane, select the Attachments tab and then click Expand Ca.

On the Attachments tab, select the file that participated in the Bluebeam session.

To view the session details associated with the attachment, select the Bluebeam Log tab.

The Bluebeam Log tab toolbar options:

» Find on Page
» Refresh

The Bluebeam Log tab contains the following columns:

Column Name Description

Status The status of the Bluebeam studio session
of the sent file.

Sent File Name The name of the sent file.

Rev. No The revision number of the sent file.

Pub. No The publishing number of the sent file.

Received File Name The name of the received file.

Session ID The ID of the Bluebeam studio session.

Session Name The name of the Bluebeam studio session.

Last Updated By The name of the user that performed the
last action for the Bluebeam studio
session.

Last Updated The date and time of when the last action

was performed for the Bluebeam studio
session.

The gear menu ( & ) for each file contains the following options:

» When the session is still active

» Finalize
» Get Session Status

» When the session is still finalized

» Download Markup File
» Download JSON File

19
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Notes:

= Any user who has access to the file will be able to see the files
returned from Bluebeam. These include the Markup and JSON files.

= If the session is Active, you can get the session details by clicking the
hyperlink associated with the Session ID.

20
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The Bluebeam Studio Sessions sub-node captures all the Bluebeam studio sessions that are
present at the given level. At the Company Workspace level, this node captures all the
Bluebeam studio sessions initiated from Document Manager (DM), BP record attachments, and
Bluebeam Studio Sessions. When you select the Bluebeam Studio Sessions sub-node (which
is available through User mode in the Document Manager node of the Company Workspace
tab or Project/Shell tab), the Bluebeam Studio Session log displays the Bluebeam studio
sessions within the Company Workspace or Project/Shell. The log has the following elements:

» Toolbar

» Grid displaying the list of all the Bluebeam studio sessions within the Company Workspace
or Project/Shell

» Right pane capturing the details of each Bluebeam studio session
The Bluebeam Studio Sessions log toolbar options:

Option Description

Create Lets you create a Bluebeam studio
session. This option is only available if you
have the required permission.

View Lets you set the view of the log through
selecting one of these options or creating
your own view:

All

Group by Status
Created by Me
Create New View
Manage Views

v v v v Vv

Edit View Lets you edit your currently selected view.

Refresh Lets you update the information of the
items listed on the log.

Print Lets you:

» Print

» Export To CSV
» Export To Excel

Find on Page Lets you activate the find cells for each
column to find a particular item.

The Bluebeam Studio Sessions log grid column headings:

» Session ID
» Session Name

21
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Status

Session Start Date
Session End Date
Source

Last Updated
Lasted Updated By
Creator

v v v vV vV v Vv

Note: The Bluebeam Studio Sessions node, at the company level,
includes session details that have initiated from within the business
process attachments.

When you select a Bluebeam studio session, the Bluebeam Studio Sessions log tabs in the
right pane include:

» Sent Files tab

» Reviewers tab

» Received Files tab

» Finalize History tab

To open a Bluebeam studio session, you can double-click the Bluebeam studio session or click

the gear menu ( i ) and select Open Bluebeam Session. After you open a Bluebeam
Session, the Bluebeam Session overlay opens.

In This Section

Creating a Bluebeam Studio Session in Bluebeam Studio Sessions ....................... 23
Opening a Bluebeam Studio Session in Bluebeam RevU ............ccccooeiiiiiiiiiiiiiennn. 24
Editing a Bluebeam Studio SESSION..........ccuviiiiiiiiieeiieeees e 25
Finalizing a Bluebeam Studio SESSION............uuuiiiiiiiiiiiiiiiiiiiieiee s 26
Deleting a Bluebeam Studio SESSION............uuuiiiiiiiiiiiiiiiiiiiieiiiieeiiee s 28
WOrKing With LOG VIEWS ...ttt e e e e e e e e e e e 28
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Creating a Bluebeam Studio Session in Bluebeam Studio Sessions

Notes:

= When a Bluebeam session with files is created in Unifier, these files
can also be viewed in Bluebeam Revu as they are associated with a
Bluebeam Project. Ensure that you do not delete the project in
Bluebeam Revu or Bluebeam portal as this will cause the session to
fail in Unifier. Unifier will not be able to return the markup documents
if the project is deleted.

= Bluebeam sessions created in Unifier should be finalized only in
Unifier and not in Bluebeam Revu. The "Received" files, that is, the
markup documents, will be available only if the corresponding
session is finalized from Unifier.

To create a Bluebeam studio session in the Bluebeam Studio Sessions node:

1) Click the Company Workspace tab or project/shell tab.

2) In the left Navigator, select Document Manager, and then select Bluebeam Studio
Sessions.

3) Click Create.
4) Upon creation, log on to your Bluebeam account.

Note: You must use the same Bluebeam account going forward.

5) Ifitis the first time, you will be prompted to grant access to your Studio data by clicking
Allow.

Create Bluebeam Studio Session will open.

6) One or more files must be added by clicking Add Files. The files listed here are from the
Document Manager.

7) After inputting the required Session Name and the associated user or users in To, click
Create Session.

Note: At any given point in time, a document may only be included in
one active Bluebeam studio session.

Create Bluebeam Studio Session Window

On the left side of the Create Bluebeam Studio Session window, the following fields are
displayed:

Field Description
Session Name The name of the Bluebeam studio session.
To The user or users that are associated with

the Bluebeam studio session. These users
can join the session in Bluebeam Revu.
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Field Description

External Users The user or users outside of Unifier that
are associated with the Bluebeam studio
session. These users can join the session
in Bluebeam Revu.

Message (Optional) Any additional descriptions, notes,
reminders and so on.

Session End Date The intended date for the Bluebeam studio
session to end.

Source The origin of where the document was
added from.

The right side of the Create Bluebeam Studio Session window contains the Review Files tab.
This tab contains the following fields:

Field Description

Name The name of the document.

Title The title of the document.

Size The byte size of the document.
Location The folder location of the document.

Opening a Bluebeam Studio Session in Bluebeam Revu

To open a Bluebeam studio session in Bluebeam Revu:

1) Click the Company Workspace tab or project/shell tab.

2) In the left Navigator, select Document Manager, and then select Bluebeam Studio
Sessions.

3) Click the gear menu ( & ) or right-click the session to review and select Open in Bluebeam
Revu.

4) The Bluebeam Session will open and the files added to the session can be viewed.

Note: The option to Open in Bluebeam Revu is available only for the
studio session creator and reviewers.

24
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Editing a Bluebeam Studio Session

To edit an active Bluebeam studio session:

1) Click the Company Workspace tab or project/shell tab.

2) In the left Navigator, select Document Manager, and then select Bluebeam Studio
Sessions.

3) Double-click to open the session.
The Bluebeam Session will open.

4) You can edit the session to add/remove files, add/remove reviewers, change the end date,
and so on.

On the left side of the existing Bluebeam Studio Sessions window, the following fields are
displayed:

Field Description

Session ID The ID of the Bluebeam Studio session.
This field cannot be edited.

Session URL The URL of the Bluebeam Studio session.

This field cannot be edited.

Session Name The name of the Bluebeam studio session.
This cannot be edited.

To The user or users that are associated with
the Bluebeam studio session. These users
can join the session in Bluebeam Revu.

External Users The user or users outside of Unifier that
are associated with the Bluebeam studio
session. These users can join the session
in Bluebeam Revu.

Message (Optional) Any additional descriptions, notes,
reminders and so on.

Session End Date The intended date for the Bluebeam studio
session to end.

Source This will either display Document Manager
or the business process name and record
number.

The right side of the existing Bluebeam Studio Sessions window contains the Review Files
tab. This tab contains the following fields:

Field Description

Name The name of the document.
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Field Description

Title The title of the document.

Size The byte size of the document.

Location The folder location of the document. This

option is seen when the session is for files
from Document Manager.

Tab Name The location of the attachment. This
options is seen when the session is for
attachments from a business process
record.

Finalizing a Bluebeam Studio Session

If you are the creator of the Bluebeam Studio session or if you have the Full Control permission,
you can finalize an Active session after the review is complete. After a session is finalized, the
files that are part of the session will be sent back to Unifier and can be viewed in the Received
Files tab.

To finalize a session:

1) Gotothe Company Workspace tab or project/shell tab and switch to User mode.

2) In the left Navigator, select Document Manager, and then select Bluebeam Studio
Sessions.

3) Inthe Bluebeam Studio Sessions log, locate the applicable session, click the gear menu (

& ) or right-click the session, and select one of the following:

» Finalize: To close the review and markup session and bring the reviewed files and
comments into Unifier for subsequent action, select this option.

» Finalize and Revise Original File: This option is only available for Bluebeam Studio
sessions created from within a BP record. To close the review and markup session, bring
the reviewed files and comments into Unifier for subsequent action, and replace the
original file with the revised one, select this option. If the session involves multiple files,
all files are updated. If a session has been finalized without replacing the original file (or

files), you can replace the original file with the revised one later. For more information,
see Replacing the Original File with a Revised File.

Note: You can only use the Finalize and Revise Original File option or
the Revise Original File option (explained later) once per file or session.

» Get Session Status: To view the status of the session, select this option.

If you select one of the Finalize options, the status of the session and all associated
documents changes from Active to Finalized (under the Bluebeam Session Status column).
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For Bluebeam sessions initiated in the Documents sub-node of the Document Manager node,
and by way of the Bluebeam Studio Session node, you can download the sent and received
files if you have "Download" access to the files used to create session.

For Bluebeam sessions initiated in a Business Process record, you will have "Download" access
only if you have one of the following:

» You have at least the View permission for the Business Process record.

» You are a part of the Business Process workflow (as an assignee). In this scenario, the
Business Process record is a Workflow Business Process.

Replacing the Original File with a Revised File

If you are the creator of the Bluebeam Studio session or if you have the Full Control permission
and the session was finalized without replacing the original file or files, you can subsequently
replace the original files with the revised ones. (You can only perform this action on a record that
is not yet in a Terminal status or has not reached a Terminal step in a workflow.) You can select
one file or multiple files for revision.

Notes:

= After the session is finalized, the Revise Original File option is
available for one-time use. For a workflow BP, you must be judicious
in choosing at what state of the workflow a document can be revised.
As stated previously, the system does not restrict revision unless the
BP record in a Terminal status or has reached a Terminal step.

= [f there are multiple files with a mixture of Yes and No in the Original
revised with received file column, you can only select the files that
have not been revised yet (that is, the column indicates No).

To replace the original file with the revised one:

1) Gotothe Company Workspace tab or project/shell tab and switch to User mode.
2) Inthe left Navigator, select Document Manager, and then select Bluebeam Studio
Sessions.

You can also complete this step from within a BP record. To do so, open the BP record,
select Expand Attachments, and then select the document that participated in a Bluebeam

session. In the right pane, select the Bluebeam Log tab. Click the gear menu ( ) and
select Revise Original File.

3) Inthe Bluebeam Studio Sessions log, select the applicable session.
4) In the right pane, select the Received Files tab.

5) For the applicable file, click the gear menu ( ) and select Revise Original File.

6) When the alert appears, click OK to continue.

The original file is updated and the Original revised with received file column is updated to
Yes on the Received Files tab. You can also view the list of revised files for a BP on the
Attachments tab (Revised column) and on the Revisions tab in the Document Manager.
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Deleting a Bluebeam Studio Session

To delete a Bluebeam studio session:

1) Click the Company Workspace tab or project/shell tab.

2) In the left Navigator, select Document Manager, and then select Bluebeam Studio
Sessions.

3) Click the gear menu ( i ) or right-click the session and select Delete in Bluebeam.

4) Upon deleting, the status of the session and all associated documents will change from
Active to Deleted in Bluebeam (under the Bluebeam Session Status column).

Note: Only active Bluebeam studio sessions may be deleted in
Bluebeam.

Working with Log Views

Use the View drop-down list to customize the Bluebeam Studio Sessions log to display files
based your filter criteria. You can use the following pre-defined views or create your own view:

All

Group by Status
Created by Me
Create New View
» Manage Views

»
»
»
4

If the option DM View is available, it enables you to see the views defined in Log views, in
Document configuration, at runtime. In such scenario, you can only see the active views at
runtime, and you can see all active views pertaining to the Documents log, if you who have
permission to access to the DM log.

To create a new view:

1) Go to your Bluebeam Studio Sessions log.

2) Click the View drop-down list and select Create New View to open the New View page.
3) Onthe New View page, enter a name for your new view under the field Save View As.
4) Inthe Columns tab, select columns that you want to display.

5) Select the columns that you want to remain static on the page from: Lock after selected
Column drop-down list.

In addition to arranging the columns, you can go to the Filters, Group By, and Sort By tabs
to customize the new view by applying more refined selections.

6) Click Save to create your new view.

Your new view appears in View drop-down list.
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To manage your views:

1) Go to your Bluebeam Studio Sessions log.

2) Click the View drop-down list and select Manage Views to open the Manage Views
window.

Use the Manage Views to create, delete, or hide views within any log. In addition, you can
reorder views by dragging and dropping them in the Manage Views window.

3) When finished, click Apply.

Your arrangement appears in the View drop-down list.
To edit or delete an existing view:

1) Go to your Documents log.

2) Click Edit View & .

Note: If you modify the view and do not save the changes, the system
keeps the existing name and adds the word "Modify" to the existing
name.

You can edit the view of the following elements on your log:
» Columns
» Filters
» Group By
» Sort By
3) Click Apply when you have finished editing.

Finding on Page

The Find on Page option enables you to find items on the displayed page.
1) Click Find on Page = .

2) After the system inserts a new row, enter your search parameters.

The system displays a list of files, folders, subfolders, or shortcuts that match the criteria you
entered.

If you decide to cancel the find for one of cell, you must remove the parameters that you have
entered. If you decide to cancel the find for an entire row, you must click Find on Page == .

Sorting Columns

You can sort columns in the Bluebeam Studio Sessions log and the Search Results page. The
View menu is prefixed with the word Modified if the sort is applied to the columns.

To sort columns, click the up and down arrows next to the column name.
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Bluebeam Studio Sessions Log Properties Tabs

Within the Bluebeam Studio Sessions sub-node and upon selecting a Bluebeam studio
session, you can view the following properties tabs:

Sent Files tab

This tab will show a list of all the documents that were added by the studio session creator while
initiating the Bluebeam studio session. This tab contains the following toolbar options:

» Download all files as Zip file
» Print (Export To CSV and Export To Excel)
» Find on Page

The Sent Files tab contains the following columns:

Column Description

File Name The name of the sent file.

Rev. No The revision number of the sent file.
Pub. No The publishing number of the sent file.
Title The title of the sent file.

Size The size of the sent file.

Location The folder location of the sent file.

The gear menu ( i ) for each file contains the following options:

» Open
» Download

Reviewers tab

This tab will show the list of all the reviewers added to the session. The list will include both
Unifier users as well as external users.

For external users, the Review name will include the email address till the time that system can
fetch the User Name of the reviewer. This tab contains the following toolbar options:

» Print (Export To CSV and Export to Excel)
» Find on Page

The Reviewers tab contains the following columns:

Column Description

Reviewer Name The name of the reviewer.
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Column Description

Review Status The status of the review by the reviewer.
Permissions The permissions of the reviewer.
Reviewer Status The status of the reviewer.

The Received Files tab will show a list of all the reviewed documents and comments/markup
files after the session is finalized or archived. The gear menu ( {3 ) for each item contains the
Assign Full Control Permission option.

Gear menu options of Assign Full Control Permission (for users who have Mark Up
Permission can be assigned Full control permission by clicking gear) and Assign Mark up
Permission (for users who have Full Control Permission can be assigned Full Markup
Permission) will be seen. The gear menu is only seen for the studio session creator.

To assign full control permission on a document in Bluebeam:

1) Click the Company Workspace tab or project/shell tab.

2) Inthe left Navigator, select Document Manager, and then select Bluebeam Studio
Sessions.

3) Select the Bluebeam studio session in which you want to assign full control permission to a
user.

4) In the right pane, click the Reviewers tab.
5) Click the gear menu or right-click the user and select Assign Full Control Permission.

Note: Only in active Bluebeam studio sessions may you assign full
control permission to users.

Received Files tab
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Files are sent from Unifier to Bluebeam either from the document manager or from the
Bluebeam Studio Sessions node. Subsequently, the file is reviewed in Bluebeam and is
brought back into Unifier, after the session creator finalizes the session. The file can be seen in
the Received Files tab in the Bluebeam Studio Sessions node as well as in the Bluebeam
Log tab of the corresponding file.

This tab contains the following toolbar options:

» Download all files as Zip file
» Print (Export To CSV and Export To Excel)
» Find on Page

The Received Files tab contains the following columns:

Column Description
File Name The name of the received file.
Rev. No The revision number of the received file.
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Column Description

Pub. No The publishing number of the received file.

Size The size of the received file.

Original revised with received file Indicates whether the original file was
updated with the file received.

The Received Files tab lists files that are received. The gear menu ( & ) for each file contains
the following options:

» Download Markup File
» Download JSON File

For Bluebeam sessions initiated in the Documents sub-node of the Document Manager node,
and by way of the Bluebeam Studio Session node, you can download the sent and received
files if you have "Download" access to the files used to create session.

For Bluebeam sessions initiated in a Business Process record, you will have "Download" access
only if you have one of the following:

» You have at least the View permission for the Business Process record.

» You are a part of the Business Process workflow (as an assignee). In this scenario, the
Business Process record is a Workflow Business Process.

Finalize History tab

The Finalize History tab will show the history of the Finalize session action performed on a
session.

This tab contains the following toolbar options:
» Find on Page

» Refresh

The Finalize History tab contains the following columns:

Column Description

Initiated By The user that initiated the session
finalization.

Finalized Date The date that the session was finalized.
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Column Description

Status The status of the finalization. The status
may be any of the following:

» In Progress

» Success

» Failed
Any errors encountered at the time of
finalizing the session will be seen in the

Error Details section of the Finalize
History tab.

Line items created for all Comments? Indicates whether line items were created
based on the comments received.

Viewing Markups and Comments

To view markups and comments:

After a Bluebeam Review session has been finalized, navigate to the Bluebeam Log tab in
the attachments tab to view the Received file from Bluebeam.

The received file shows markups and comments. The corresponding JSON file shows
comments as line items in the Bluebeam tab.
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